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1. EXECUTIVE SUMMARY 

CGS Interna0onal FX's online trading pla[orm is fast, convenient, seamless and customisable. MetaTrader 4, 
also known as MT4, is one of the most widely known electronic trading pla[orm for Forex trading. Developed 
by MetaQuotes So]ware and released in 2005, MT4 is packed with exci0ng features to fit the trading needs 
of online retail foreign exchange specula0ve traders. We provide the MT4 Trading Terminal available on 
desktop; and also MT4 Mobile Trading Applica0on on both Android and iOS. 

You can download CGSI MT4 with the following links below: 

• Desktop Terminal 
hbps://download.mql5.com/cdn/web/22960/mt4/cgsintlsecuri0essg4setup.exe 

• Mobile iOS 
hbps://download.mql5.com/cdn/mobile/mt4/ios?server=CGSIntlSecuri0esSG-CGSIntlSecuri0esSG 

• Mobile Android 
hbps://download.mql5.com/cdn/mobile/mt4/android?server=CGSIntlSecuri0esSG-CGSIntlSecuri0esSG 

 

To download on Mac OS, you can follow the steps provided by MetaQuotes 

hbps://www.metatrader4.com/en/trading-pla[orm/help/userguide/install_mac 

 

Apart from that, the user will be able to monitor the order status and manage the forex por[olio with ease. 
With just a click of the mouse, the user will be able gather relevant market informa0on to make informed 
decisions. 

 

2. SYSTEM REQUIREMENTS 

OperaIng system: - Windows 7 and above 

Processor: - 1.5 GHz or higher 

RAM (memory): - 1 GB or higher 

Internet connecIon: - 1.5 Mbps broadband or beber 

 

 

 

 

https://download.mql5.com/cdn/web/22960/mt4/cgsintlsecuritiessg4setup.exe
https://download.mql5.com/cdn/mobile/mt4/ios?server=CGSIntlSecuritiesSG-CGSIntlSecuritiesSG
https://download.mql5.com/cdn/mobile/mt4/android?server=CGSIntlSecuritiesSG-CGSIntlSecuritiesSG
https://www.metatrader4.com/en/trading-platform/help/userguide/install_mac
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3. GETTING STARTED WITH CGSI MT4 TERMINAL  

3.1  InstallaIon of MT4 Desktop Terminal  

i. Download MetaTrader 4 Terminal from our website at hbps://www.cgsi.com.sg/en/metatrader 
and run the file a]er download has completed.  
 

ii. Carefully read and accept the MetaTrader 4 License Agreement prior to installa0on. 

 
 

iii. Click Next to start the installa0on. This may take a few minutes. 

 

https://www.cgsi.com.sg/en/metatrader
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iv. A]er the installa0on has been completed, click on Finish to run the program. You will see this 
account opening screen. Choose the trading server CGSIntlSecuriIesSG-CGSIntlSecuriIesSG 
and click Next. You will be prompted to login to your trading account. 
 

 
 

3.2  Login of Account  

You will be prompted to login with your ID (Account Number) and Password upon launching of the 
MT4 pla[orm. 

 

If the login box does not appear, you can launch it by clicking on the File > Login to Trade Account 
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i. Logging in for the first Ime (New clients) 
 
Your account number and first 0me login password will be sent to you via 2 separate emails.  
 
Upon successful login, you are required to change your password and proceed to contact the FX 
Dealing Desk at +65 6671-9908 to ac0vate the trade access for your trading account. Our FX 
Dealing Desk is available from Monday 6am to Saturday 6am (SGT, GMT +8). 

 
Change password: Tools > OpIons > Server tab > Change (“master” password) 
 

 
 

Trade access will only be enabled a]er you have changed your password at first login and a]er 
you have met the ini0al deposit requirements. 

 
 

ii. ExisIng clients  
 
If the bobom right side of the pla[orm screen is showing “no connec0on”, it means that you 
are not logged in. You are successfully logged in if you see the connec0on speed at the bobom 
right side of the screen. Eg. 14/2 kb  
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Should you be unable to log in, you can click on the Journal tab as shown below to iden0fy what 
may have been the issue. E.g. Invalid account. 
 

 
 
 

4. NAVIGATING THE PLATFORM  

4.1  Market Watch Window  

By default, some currency pairs will be shown in the Market Watch list. You can edit the list by right 
clicking and selec0ng on “Symbols” as shown below. 

 

 

To add a currency pair into the Market Watch list, you have to select the currency pair of your 
choice and click “Show”.  

To remove a currency pair from the Market Watch list, you have to select the currency pair that you 
want to remove and click “Hide”.  

To see the contract specificaIon for a currency pair, right click on the currency pair of your choice 
and click “Specifica0on”.  
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4.2  Order Ticket  

To place a buy or sell order, you can launch the Order 0cket by clicking on the currency pair on the 
Market Watch list.  

The Volume column in the order 0cket is defined by lot size. The standard contract size is 1 lot 
equals to 100,000 units.  

For example, if you want to ini0ate a posi0on of 10,000 units, you will have to input 0.1 into the 
Volume column.  

 

The default order type is a “Market Execu0on Order”.  

A Market Order is an order that will be executed immediately at the current market price. 

- Stop Loss: To liquidate your posi0on when your indicated stop loss price is triggered to cut 
losses  

- Take profit: To liquidate your posi0on when your indicated take profit price is triggered to 
take your profits  

- Comments: You can input notes for that par0cular trade which will be reflected in the 
Account History  

 

If you do not specify a value for Stop Loss and/or Take Profit column, the order will be ini0ated 
without a stop loss or take profit price. 
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For order types other than Market Execu0on, select Pending Order at the dropdown box under 
“Type”. 

 

You are required to specify your desired execu0on price for Pending Order types. The op0on to set 
an expiry date (Good Till Date “GTD”) for your order is also available. 

 

 

You can view all your orders under the “Trade” tab.  
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To cancel or amend a queuing order, right click on the specific order and click on “Modify or Delete 
Order”.  

To close an open posi0on, right click on the specific order and click on “Close Order”.  

Please note that your posi0ons will not be nebed off if you ini0ate a new order in the opposite side 
for the same currency pair traded. It will result in an addi0onal open posi0on. 

If you wish to par0ally close your trade, double click on the posi0on, specify the volume that you 
wish to close and then press on the yellow bubon to close. (1 lot = 100,000 units) 
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4.3  Order Types  

Market Order  

Market Order is a commitment to buy or sell a security at the current price. Execu0on of this order 
results in the opening of a trade posi0on in which the security will be bought at ASK price and sold 
at BID price. Stop Loss and Take Profit orders can be abached to a market order. 

 

Pending Order  

Pending Order is a commitment to buy or sell a security at a pre-determined price in the future. The 
order will only be executed provided the future quote reaches the pre-defined level.  

• Buy Limit Order – an order to buy a security at or below a specified price (order placed at 
or below current market price)  

• Sell Limit Order – an order to sell a security at or above a specified price (order placed at 
or above current market price)  

• Buy Stop Order – an order to buy a security when its price reaches the pre-defined point 
(stop price), in which it becomes a market order (order placed above current market price)  

• Sell Stop Order – an order to sell a security when its price reaches the pre-defined point 
(stop price), in which it becomes a market order (order placed below current market price)  

Trailing Stop Order  

Stop Loss is intended for reducing of losses where the symbol price moves in an unprofitable 
direc0on. If the posi0on becomes profitable, Stop Loss can be manually shi]ed to a break-even 
level. To automate this process, Trailing Stop was created.  

Trailing Stop is always abached to an open posi0on and works in client terminal, not at the server 
like Stop Loss. Trailing Stop order will only remain ac0ve when MetaTrader is running and 
connected to the internet. Your Trailing Stop order will not work if the terminal is off, but your Stop 
Loss order will remain ac0ve, assuming it was placed earlier than the Trailing Stop. Trailing Stop is 
not available on MT4 mobile trading applica0on.  

To set the trailing stop, right click on the specific outstanding posi0on to find the Trailing Stop 
func0on. Select the desirable value of distance between the Stop Loss level and the current price. 

 MT4 Trailing Stop will be ac0vated when your trade is in the money. If the price changes in the 
more profitable direc0on, trailing stop will make the Stop Loss level follow the price automa0cally, 
but if profitability of the posi0on falls, the order will not be modified anymore. Thus, the profit of 
the trade posi0on is fixed automa0cally. A]er each automa0c Stop Loss order modifica0on, a 
record will be made under the Journal tab. 
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4.4  Navigator Window  

Accounts will show you which trading server you are currently logged in to. Indicators will show you 
the list of indicators that are available on the pla[orm. 

Alterna0vely, you can also add your preferred indicators and u0lise other char0ng tools from the 
dropdown box by clicking on “Insert” at the top of the screen. 
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4.5  Charts  

You can add charts by clicking on File > New Chart or click on the New Chart icon.  

 

 

 

You can open up to 99 charts simultaneously, draw trend lines, change 0me frames, add in technical 
indicators and trading signals, etc. according to your trading preferences.  

You can also customise your chart colours and other sevngs for your charts by clicking on Chart > 
ProperIes. 
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4.6  Trade Tab  

Under the Trade tab, you can view your outstanding open posi0ons and queuing orders.  

 

4.7  Exposure Tab  

Under the Exposure tab, you can view your current por[olio exposure, margin u0liza0on, available 
margin for trading and cash balance of your account. 

 

4.8  Account History Tab  

Under the Account History tab, you can view your transac0on history including total withdrawal and 
deposit, and total profit or loss from your trades. 

 

 

You can view the report or detailed report on a par0cular transac0on by right clicking on the 
transac0on. 
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You can also drag and drop that par0cular transac0on to the chart and it will automa0cally show 
you the entry and exit point for that trade. 

 

 

4.9  Alerts Tab  

Under the Alerts tab, you can set alerts for different currency pairs according to your preferred 
condi0ons, value, and dura0on, by right clicking and selec0ng “Create”. 
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Once you have defined the condi0ons (Sound or No0fica0on Pop Out), the alert will be created 
when you click on “OK”.  

The alerts created will be reflected at the Alerts tab. 

You can edit an exis0ng alert by double clicking on it. 

 

 

4.10 ArIcles Tab 

Under the Ar0cles tab, you can view all the free ar0cles that MT4 provides. These ar0cles include 
market news, trading strategies and algorithms. 

 

*These contents are provided by MetaQuotes and are in no way approved or recommended by CGS 
Interna0onal Securi0es Singapore Pte. Ltd. 
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4.11 Code Base Tab 

Under the Code Base tab, you can view all the relevant trading strategies algorithm that other users 
have posted that are provided by MT4. Do note that some are chargeable. 

 

*These contents are provided by MetaQuotes and are in no way approved or recommended by CGS 
Interna0onal Securi0es Singapore Pte. Ltd. 

 

You can also run your own wriben algorithm trading strategies on the MetaEditor system. 
MetaEditor will launch when you click on the icon as shown. 
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5. GETTING STARTED WITH CGSI FX MT4 MOBILE TRADING APPLICATION 

5.1  InstallaIon of MT4 Mobile Trading ApplicaIon 

Search for MetaTrader 4 on the Google Play Store (Android) or Apple App Store (iOS) and download 
the MetaTrader 4 mobile applica0on. 

 

5.2  Login of Account 

i. A]er the applica0on has been successfully downloaded, launch the applica0on and click on 
New Account > Login to an exisIng account (under Manage Accounts for Android or 
Sevngs tab for iOS). 

 

ii. Search for “cgsi” and choose “CGSIntlSecuriIesSG-CGSIntlSecuriIesSG” server 

 



 

Page | 19  
 

 

iii. Key in your Login ID and Password to login to your MT4 trading account. 

 

 

6. NAVIGATING THE MOBILE TRADING APPLICATION 

6.1 Quotes Tab 

Under the Quotes tab, you can view the price quotes for currency pairs. 

To add/remove a currency pair from the Quotes list, you have to select the icon on the top right 
corner of the screen before selec0ng a currency pair to add/delete. 
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A pop up will appear when you click on the currency pair on the Quotes screen. 

 

 

To open the order 0cket, select “New order” (Android) or “Trade” (iOS).  

To view the chart, select “Open chart” (Android) or “Chart” (iOS). 

To see the contract specifica0on, select “Symbol proper0es” (Android) or “Details” (iOS). 

 

6.2 Chart Tab 

Instead of opening a chart from the Quotes tab, you can view charts from the Chart tab as well. 
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You can customise your char0ng, change the chart 0meframe, customise technical indicators and 
signals, draw trend lines, and also open an order 0cket from the Chart tab. 

You can view the chart in full-screen by rota0ng your device to landscape mode. 

 

6.3 Trades Tab 

Under the Trades tab, you will be able to view your overall account balance, equity balance, free 
margin available for trading, margin level and total margin u0lised. 

Your overall floa0ng Profit or Loss is shown on the top le] side of the screen. 

 

 

You will be able to see all your outstanding open posi0ons under “Posi0ons” whereas your queuing 
orders will be listed under “Orders”. 
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To close an outstanding open posi0on, press and hold on the specific posi0on and select “Close 
order” (Android) or “Close” (iOS). 

 

The order types available on the mobile applica0on is the same as the order types on the desktop 
applica0on. However, Trailing Stop order is not available on mobile applica0on. 

The default order type is “Market Execu0on”. 

 



 

Page | 23  
 

 

6.4 History Tab 

 

Under the History tab, you can view all your transac0on history, total profit or loss, account 
balance, deposit and withdrawal amount. 

These informa0on can be filtered by Daily, Weekly, Monthly, or a custom 0meframe of your choice. 

 

 

 

  

 

 

 

 

Disclaimer: Informa0on in this document is deemed accurate at the 0me of publishing. However, the informa0on and features 
elaborated in this user guide is subject to change without prior no0ce. No part of this document may be reproduced or transmi@ed 
in any form or by any means, electronic or mechanical, for any purpose, without the express wri@en permission of CGS Interna0onal 
Securi0es Pte. Ltd. The company may have patents or pending patent applica0ons, trademarks, copyrights, or other intellectual 
property rights covering subject ma@er in this document. The furnishing of this document does not give you the license to these 
patents, trademarks, copyrights, or other intellectual property.  

 


